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FED5  Conical spring drawings with end coils

Conical spring is drawn with end coils now in section drawing, in "Quick3" and "Quick4" View,
and in animation.

FED1+,2+,5,6,7: Warning tau2 > tauz min !
A new warning tau2 > tau z min ! refers to minimum tensile strength from table fedrmmin.dbf, if
material was selected from database, and if a table with tensile strength tolerances is available for
the selected material. Tensile strength data in fedrmmin.dbf and fedrmmmax.dbf refer to wire as
delivered. If tensile strength of the finished spring higher than that of the raw wire (i.e. by age
hardening of stainless steel) you can ignore the warning. If you configure "Hide warnings" or
uncheck "display Rm min/max, taumin/max" the warning is disabled.



FED6, FED7: Animation with load-deflection diagram

Load-deflection diagram is drawn now side-by-side with the animated spring, and a point moves
along the load-deflection curve due to deflection of the spring.



FED1+, FED3+, FED5, FED6 - Input mandrel diameter
Maximum usable mandrel diameter for compression springs or torsion springs is calculated and
displayed in the production drawing with mandrel diameter "<= x.x". As alternative, you can now
input mandrel diameter with +/- tolerance. If  entered diameter plus tolerance is larger than
calculated maximum, you get an error message.

FED1+, FED5, FED6:  taukn and taukc

If dynamic loaded, shear stress is multiplied by dynamic stress correction coefficient k. Dynamic
zone lies between spring deflection s1 and s2 with stresses tauk1 and tauk2. Block stress tauc is
static.  Thus tauk2 can be higher than tauc. Theoretical dynamic stress at block (taukc) and at usable
length (taukn) is listed in brackets now with load-deflection diagrams and stress-deflection diagram.

FED1+, FED3+, FED6: 3D helical center line for rectangular and elliptic wire
3D centerline can be drawn for all wire types now. For ground end coils, 3D line begins near z=0,
and for raw end coils near z=d/2. Height of the centerline of an unloaded spring can be calculated
from unloaded spring length L0 and block length Lc: L0center = L0-Lc+nt*dmax
If you want a drawing with nominal dimensions without tolerances,  set wire tolerance to 0 at "Edit-
>Material", then  check Lc=(nt+1)*dmax if raw end coils or Lc=nt*dmax if ground end coils at
"Edit->Production".



FED4:  F-L Diagram
Spring length instead of deflection is drawn on the x axis of the new F-L diagram in FED4.

FED4:  Animation
Animation simulates deflection of the disk springs on screen. You can define start length, end
length, number of steps and pause. A moving point on the load-deflection diagram shows present
load of the spring package.



WN9  CAD profile drawing min/max

Profile of  straight splined shaft and splined hub has been drawn with mean tolerance until now. In
the new version of WN9 you can enter dimension or click min/mean/max buttons to set dimension
with desired tolerance for spline profile drawings.

SR1 - Small Thread Size
Thread sizes M1.6, M2 and M2.5 for hexagon socket head screws according to EN ISO 4762 have
been added to the database.

WN1, ZAR1+, ZAR2, ZAR5, ZAR6  Production Drawing in standardized scale
Until now, drawings have been scaled to fit in the available drawing area. Now, hubs and gear
wheels are drawn in next standardized scale according to ISO (M1:1, 1:2, 1:5, 1:10 .. M2:1, 5:1,
10:1 ..).



Configurable border width of ISO 7200 drawings with coordinates and mm scale

According to ISO 5457, border width to drawing area is 10 mm (bottom, top, right) and 20 mm left.
Old DIN 6771 defined 5 mm and 15 mm left. This reduces drawing area by 10 mm in height and
width. Until now, production drawings (A4) and Quick4 View (A3) were drawn with 5 mm border.
Now you can configure ISO 7200 drawing with 5 mm or 10 mm border. If 10 mm border
configured, you can fill the border with coordinates A,B,C,D  1,2,3,4.. and/or a millimeter scale.

However, the 10 mm border can not be used with each production drawing until now, because i.e.
the A4 table drawings of the springs require the complete drawing area.
But "Quick4" drawings and "Quick3 Production Drawing" in each program had been checked and
modified to fit in the ISO 7200 drawing with 10 mm border.



ISO 7200 title block with modification index
According to ISO 7200, drawing modifications are no longer described. Only the modification
index is listed as letter A,B,C. Nevertheless, you can now configure to list the modifications directly
above the title block

Extend Title Block by self-defined drawing elements

If you want to extend the standard title block by self-defined standard specifications, symbols and
drawing elements, you can create a title block extension drawing and save it as DXF file. Insertion
point is the left upper corner of the configured title block (ISO 7200 or DIN 6771). Create a DXF
drawing and convert into a DX$ file, copy into temporary directory and set read-only file attribute.
With different file names the drawing extensions are used with A4 drawing, A3 drawing (Quick4),
or with each production drawing:
$HEAD_0.DX$: drawing inserted above title block.
$HEAD_4.DX$: drawing inserted above title block, A4 production drawing only.
$HEAD_3.DX$: drawing inserted above title block, A3 drawing (Quick4) only.

Extend drawing by self-defined drawing elements
You also can insert self-defined drawings at coordinate origin (0/0) of the generated drawing.
Convert your DXF drawing into DX$, save in temp directory and set R/O attribute as described
previous.
$INSERT_0.DX$: drawing inserted in A3 or A4 production drawing
$INSERT_3.DX$: drawing inserted in A3 production drawing (Quick4)
$INSERT_4.DX$: drawing inserted in A4 production drawing
At  "File->Settings->Drawing" you have to configure that self-defined drawing elements must be
used.



Open manual
Each program got a new menu item "Help->Manual" to run the electronic manual. Manual is
delivered as PDF files and one index HTM file. Your computer must have installed PDF viewer and
HTML Browser (no internet connection required) to run the e-Manual. Folder with manual pdf and
htm files can be configured at "File->Settings->External". Default setting is program path.

FNAME Tool for lowercase file names
Windows makes no difference between uppercase and lowercase characters in file names, but Unix
does. If you run software and e-manual on a Unix server and get error messages "file not found"
maybe could be the reason. File names must be lowercase. You can use our tool "FNAME"
( FNAME *.* ) to convert file names in lowercase characters. Customers can download the tool at
www.hexagon.de/history/tools.

Installation with or without Setup.exe
Under Windows 10, waiting period at installation with setup.exe can be up to one minute, no idea
why. Because the blue annulus is rotating and nothing else seems to happen, it looks like setup.exe
hangs. But you have to wait until setup window closes. As alternative, you can install programs
without setup.exe. Just unzip or copy the files in a new folder. Then create a shortcut on the desktop
to run the program.

In earlier versions, setup.exe also linked HEXAGON program with file extension of the calculation
files, but since Windows Vista  HEXAGON Setup.exe fails with registering file extensions. Link
file extension with calculation program is useful if you want to start the calculation program by a
double click into the calculation file.

http://www.hexagon.de/history/tools


Tip: Link files with program via file extension
Example: Open .sr1 files with SR1+ under Windows 7

Use Windows Explorer and double click file (1.SR1)

"Select a program from a list of installed programs".                 "Browse..."

Select program (c:\hexagon\sr1\wsr1.exe), then  Open             "OK".
WSR1.EXE opens 1.SR1 file



PRICELIST  2015-11-01
PRODUCT EUR
DI1 Version 1.2  O-Ring Seal Software 190,-
DXF-Manager Version 8.7 383,-
DXFPLOT V 3.1 123,-
FED1 V27.4 Helical Compression Springs 491,-
FED1+ V27.4 Helical Compression Springs incl. spring database, animation, relax., 3D,.. 695,-
FED2 V19.1 Helical Extension Springs 501,-
FED2+ V19.1 Helical Extension Springs incl. spring database, animation, relaxation, ... 675,-
FED3+ V17.9 Helical Torsion Springs incl. prod.drawing, animation, 3D, rectang.wire, ... 480,-
FED4 Version 7.0 Disk Springs 430,-
FED5 Version 14.3 Conical Compression Springs 741,-
FED6 Version 14.8 Nonlinear Cylindrical Compression Springs 634,-
FED7 Version 12.0 Nonlinear Compression Springs 660,-
FED8 Version 6.5 Torsion Bar 317,-
FED9 Version 5.6 Spiral Spring 394,-
FED10 Version 3.2  Leaf Spring (complex) 500,-
FED11 Version 3.1  Spring Lock and Bushing 210,-
FED12 Version 2.4  Elastomere Compression Spring 220,-
FED13 Version 3.8  Wave Spring Washers 185,-
FED14 Version 1.3  Helical Wave Spring 395,-
FED15 Version 1.2  Leaf Spring (simple) 180,-
GEO1+ V5.7 Cross Section Calculation incl. profile database 294.-
GEO2 V2.6 Rotation Bodies 194,-
GEO3 V3.3 Hertzian Pressure 205,-
GEO4 V3.9 Cam Software 265,-
HPGL-Manager Version 8.6 383,-
LG1 V6.3 Roll-Contact Bearings 296,-
LG2 V2.1 Hydrodynamic Plain Journal Bearings 460,-
SR1 V20.8 Bolted Joint Design 640,-
SR1+ V20.8 Bolted Joint Design incl. Flange calculation 750,-
TOL1 V11.8 Tolerance Analysis 506,-
TOL1CON V1.5 Conversion Program for TOL1 281,-
TOL2 Version 3.3 Tolerance Analysis 495,-
TOLPASS V4.1 Library for ISO tolerances 107,-
TR1 V3.7 Girder Calculation 757,-
WL1+ V19.7 Shaft Calculation incl. Roll-contact Bearings 945,-
WN1 Version 11.5 Cylindrical and Conical Press Fits 485,-
WN2 V 9.5 Involute Splines to DIN 5480 250,-
WN2+ V 9.5 Involute Splines to DIN 5480 and non-standard involute splines 380,-
WN3 V 5.3 Parallel Key Joints to DIN 6885, ANSI B17.1, DIN 6892 245,-
WN4 V 4.4 Involute Splines to ANSI B 92.1 276,-
WN5 V 4.4 Involute Splines to ISO 4156 and ANSI B 92.2 M 255,-
WN6 V 2.9 Polygon Profiles P3G to DIN 32711 180,-
WN7 V 2.2 Polygon Profiles P4C to DIN 32712 175,-
WN8 V 1.9 Serration to DIN 5481 195,-
WN9 V 2.1 Spline Shafts to DIN ISO 14 170,-
WN10 V 3.7 Involute Splines to DIN 5482 260,-
WN11 V 1.3 Woodruff Key Joints 240,-
WNXE V 1.1 Involute Splines - dimensions, graphic, measure 375,-
WST1 V 9.3 Material Database 235,-
ZAR1+ V 24.3 Spur and Helical Gears 1115,-
ZAR2 V7.7 Spiral Bevel Gears to Klingelnberg 792,-
ZAR3 V8.7 Worm Gears 404,-
ZAR3+ V8.7 Worm Gears incl. profile drawings, variable tooth height, OPD measure 620,-
ZAR4 V3.7 Non-circular Spur Gears 1610,-
ZAR5 V9.1 Planetary Gearings 1355,-
ZAR6 V3.7 Straight/Helical/Spiral Bevel Gears 585,-
ZARXP V2.0 Involute Profiles - dimensions, graphic, measure 275,-
ZAR1W V1.5 Gear Wheel Dimensions, tolerances, measure 450,-
ZM1.V2.3 Chain Gear Design 326,-



Packages

PACKAGES EUR
HEXAGON Mechanical Engineering Package (TOL1, ZAR1+, ZAR2, ZAR3+, ZAR5, ZAR6, WL1+, WN1,
WN2+, WN3, WST1, SR1+, FED1+, FED2+, FED3+, FED4, ZARXP, TOLPASS, LG1, DXFPLOT, GEO1+,
TOL2, TOL1CON, GEO2, GEO3, ZM1, WN6, WN7, LG2, FED12, FED13, WN8, WN9, WN11, DI1, FED15,
WNXE)

8,500.-

HEXAGON Mechanical Engineering Base Package (ZAR1+, ZAR3+, ZAR5, ZAR6, WL1+, WN1, WST1,
SR1+, FED1,+, FED2+, FED3+) 4.900,-

HEXAGON Spur Gear Bundle (ZAR1+ and ZAR5) 1,585.-
HEXAGON Graphic Package (DXF-Manager, HPGL-Manager, DXFPLOT) 741.-
HEXAGON Helical Spring Package (FED1+, FED2+, FED3+, FED5, FED6, FED7) 2,550.-

HEXAGON Tolerance Package (TOL1, TOL1CON, TOL2, TOLPASS) 945.-
HEXAGON Complete Package (All Programs of Engineering Package, Graphics Package, Tolerance

Package, Helical Spring Package, TR1, FED8, FED9, FED10, ZAR4, GEO4, WN4, WN5,
FED11,WN10, ZAR1W, FED14)

11,500.-

Quantity Discount for Individual Licenses
Licenses 2 3 4 5 6 7 8 9 >9
Discount % 25% 27.5% 30% 32.5% 35% 37.5% 40% 42.5% 45%

Network Floating License
Licenses 1 2 3 4 5 6 7..8 9..11 >11
Discount/Add.cost -50% -20% 0% 10% 15% 20% 25% 30% 35%
(Negative Discount means additional cost)

Language Version:
- German and English : all Programs
- French: FED1, FED1+, FED2, FED2+, FED3, FED3+, FED5, FED6, FED7, FED9, WL1+.
- Italiano: FED1, FED1+, FED2, FED2+, FED3, FED3+, FED5, FED6, FED7, FED9, DXFPLOT.
- Swedish: FED1, FED1+, FED2, FED2+, FED3, FED3+, FED5, FED6, FED7, DXFPLOT.
- Portugues: FED1, FED1+
- Spanish: FED1, FED1+

Updates:
Update prices EUR
Software Update (software + pdf manual) 40,-
Software Update (software 64-bit Win + pdf manual) 50,-
Update Mechanical Engineering Package: 800 EUR, Update Complete Package: 1000 EUR

Maintenance contract for free updates: annual fee: 150 EUR + 40 EUR per program

Upgrades
For upgrades to network licenses or plus versions or software bundles, upgraded licenses are credited 75%.

Hexagon Software Network Licenses
Floating License in the time-sharing manner by integrated license manager
Individual licenses may not be installed in a network!

Conditions for delivery and payment
General packaging and postage costs are EUR 60, (EUR 25 inside Europe)
Delivery by Email (program packed, manual as pdf files): EUR 0.
Conditions of payment: bank transfer in advance with 2% discount, or by credit card (Master, Visa) net.

Key Code
After installation, software has to be released by key code. Key codes will be sent after receipt of payment.

HEXAGON Industriesoftware GmbH
Stiegelstrasse 8      D-73230 Kirchheim     Tel.+49 702159578     Fax +49 7021 59986
Kieler Strasse 1A      D-10115 Berlin      Tel. +49 30 28096996     Fax +49 30 28096997
Mobile: +49 163 7342509       E-Mail:  info@hexagon.de           Web: http://www.hexagon.de

http://www.hexagon.de

